SZECHENYI ISTVAN ALKALMAZOTT MECHANIKA
EGYETEM TANSZEK

Végeselem modszer 3. gyakorlat
Furatos lemez (ASF feladat)

Feladat: Sajat sikjaban terhelt furatos lemez

Adott:

T f Geometriai méretek:

a =1000 mm, b=2000 mm

v =5mm, d=500 mm, ahol v a lemez
vastagsaga.
Anyaga: E =2-10°MPa

v=0,3

Terhelés: f =200 i
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Szamitasi modell: (a szimmetria Ay
kihasznalasa)
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Mechanikai modell: altalanos sikfesziiltségi allapot = tarcsa feladat = sajat sikjaban terhelt
lemez feladat
Feltételezések ASF feladat esetén:

— b << atest mas jellemz6 méreteinél

— z=0 kozépfeliilet sik

— terhelésben nincsenek z iranyu erék

— Xy sikkal parhuzamos erék vastagsdgmenti ereddje az Xy sikba esik

— z=+b/2 feliiletek terheletlenek

- o,=0

Elmozdulasmez&: G(X,y)=u(x,y)& +V(X, Y)§,

oy Ty O
Fesziiltségi allapot: F=|7, &, 0
0O 0 O

Végeselem modell: négyszog alaku, linearis sikelem, elemméret 15mm.

Szemléltetés:

» A szerkezet deformacio utani alakjanak kirajzoltatasa, az elmozdulasok szemléltetése,
Az elmozdulasok szemléltetése vektorokkal a deformalatlan alakon,
A o,,0,,7,,0, fesziltségek szemleltetese a deformalatlan alakon,

A fesziiltségeloszlas szemléltetése az y = 0egyenes mentén,

VV YV V

Az alakvaltozas és fesziiltségeloszlas animalésa.



Inditsuk el az Abaqus CAE programot. Adjuk meg a munkakonyvtarat a File » Set
Work Directory... paranccsal. A megjelen6 ablakban a New work directory ala
irjuk/masoljuk be a munkakonyvtarunk helyét, vagy valasszuk ki a A select... ikonnal.
Ezutan OK-zuk le az ablakot.

Eile  Model

Mew Model Database ] Current work directory:

Qpen... Ctrl+0 Ghgames\SIMULIA\ternp

Metwork ODB Connector e | New work directory:

Close ODEB... J\Google Drive\01_education\05_VEM\Abac

Set Work Directory... Note: In file selection dialog boxes, you can
click the work directory icon te jump Pl

Sawve Ctrl+5 to the current work directory.

Save fs... Cancel |

Compress MDB...

Viewport  View

== Set Work Directory

|

JNl MODULE | PART | geometria megrajzolasa

A program megnyitasa utan alapértelmezésként a Part Modulban vagyunk. Ez a Modul

szolgal a geometria létrehozasara. Ehhez az alabbi Iépéseket kdvessuk:

1. Az eszkoztarbdl kattintsunk a Create Part ikonra. Az ennek hatasara megjelené Create

Part ablakban az alabbi beallitasokat végezzik el:
A Name utan irjuk be az alkatrésziink nevét, legyen torttarto.

A Modeling Space alatt valasszuk ki, hogy sikbeli, azaz 2D Planar geometriat
szeretnénk rajzolni.
A Type alatt hagyjuk az alapértelmezett kijelolést a Deformable elétt, mivel
alakvaltozasra képes geometriat szeretnénk.

A Base Feature alatt valasszuk a Shell-t.

Az Approximate size-ot, tehat a modellink méretét itt is beallithatnank, de erre
majd késébb visszatérink a segédracs beallitasanal, most hagyjuk az

alapértelmezett 200-on.

A fenti beallitadsok elvégzése utan kattintsunk lent a Continue... gombra.

Module: |- Part : & Create Part X
? E Marme: | furatos lemez
}i:- 2 Modeling Space

| Create [@F] () Axisymmetric
| Part

. Type Options

P =

- ® Deformable
i () Discrete rigid
=.Ee Mone available
it (O Analytical rigid
=]
.

R‘ == Base Feature
-ﬂj@, B‘Sv @) Shell
[xlzi -/L‘ (D Wire

4 i O Point
b

»

. B,

i
|: 2 % Approximate size: | 200
iy




2. A Continue... gombra kattintds utan azt tapasztaljuk, hogy a Part modul eszkdztara
megvaltozott, a rajzolast segité parancsok jelentek meg. Azt is megfigyelhetjik, hogy a
program a rajzolashoz az XY sikot ajanlja fel, és ebben a sikban automatikusan elhelyez
egy rajzolast segit6 kék segédracsot (Grid-et). A geometria megrajzolasa el6tt —
kulondsen egyszeribb geometrianal — célszerli ezen segédracs meéreteit a rajzolando
geometria méreteinek megfeleléen beallitani, igy egyszerlen meg tudjuk rajzolni a
geometriat és meguszhatjuk annak beméretezését is. A segédracs beallitasahoz
kattintsunk az eszkdztar Sketcher Options ikonjara. Az ekkor megjelend Sketcher
Options parbeszédablaknak a General flilének a Grid mezéjében végezziik el az alabbi
beallitasokat:

¢ A munkaterulet mérete legyen 2000 mm, ehhez a Sheet size soraban az Auto eldl
vegyUk ki a pipat, és irjunk be 2000-et.
e A racstavolsagot vegyuk 250 mm-re. Ehhez a Grid spacing soraban vegyuk ki a
pipat az Auto eldl és irjunk be 250-at.
¢ A geometria megrajzolasahoz elég felhasznalni a racspontokat, tovabbi bels6
segeédpontokra nincs szikségunk, ezért a Minor intervals-t allitsuk 1-re.
A fenti beallitdsok elvégzése utan kattintsunk lent az OK gombra.

Medule: | Part = Sketcher Options *
+= & General  Dimensions Constraints  Image
=
C(?‘ ¥ Selection
(]
% — Snap to grid
)i
)
(_}._ ﬂ:j Preselect geometry
Al o
= Sheetsize: 2000 | []Aute
.{|. Bb Grid spacing: | 230 [0 Auto
7, Minor intervals: | 1'%
Es ’26 (Snap spacing: 230.00)
]_& v Show gridlines: Major Miner (dynamic)
= fixd Align grid: | Origin...| |Angle...| Reset
':-: i Show censtruction geometry
&
Mazx coplanar entities to project: | 300
lslg
Max level for sketch undo: | 10
g‘:tt“oh:; oK Apply Defaults Cancel

3. A geometria megrajzolasahoz valasszuk az eszkoztarbdl a Create Lines: Connected
parancsot. Ezutan a segédracs segitségével rajzoljuk meg a lemez egyenes vonalakkal
hatarolt részeit.

Ezutan a Create Arc: Center and 2 Endpoints paranccsal rajzoljuk meg a furat negyedét
ezzel zartta tesszik a gorbénket.

e Ha végeztunk a geometria megrajzolasaval nyomjuk meg az Esc billentyt.
Ahhoz, hogy a vazlatbdl vonalakbdl all6 alkatrész legyen a lenti beviteli mezében
kattintsunk a Sketch the section for the wire melletti Done gombra (vagy nyomjuk meg a
k6zéps6 egérgombot) Ennek hatasara elkészul a Part-unk, és visszaall a Part Modul alap
eszkoztara.



A3.2

Module: |2 Part j
i w&
g+
@ Create Lines:

Connected
G2 TE
—z
{72)1 7

T

A3.3

i| Create Arc:
Center and
4 2 Endpoints

A3.4

A31 A35 Sketch the section for the wire

Sl MODULE | PROPERTY tulajdonsagok megadasa

Valasszuk ki fent a Property modult. Itt tudjuk megadni az anyagjellemzdket, illetve rud esetén
a keresztmetszeti jellemzdket. Ehhez az alabbi 3 1épésen kell végmenni:

1. Anyag definialasa: Elsé Iépésként egy anyagot kell definialnunk. Ehhez a Property modul
eszkoztarabol kattintsunk a Create Material ikonra. A megjelend Edit Material ablakban
végezzik el a kdvetkezd beallitasokat:

o Nevezzik el az anyagot: a Name: utan irjuk be, hogy acél




e A linearisan rugalmas anyagjellemzék megadasahoz a Material Behaviors
mezbben adjuk ki a Mechanical » Elasticity » Elastic parancsot
e Az ekkor megjelené Elastic mezdben az alabbi beallitasokat végezzik el:

oA Type
anyagtulajdonsagok iranyfliggetlenek)

mellett

hagyjuk

az alapértelmezett Isotropic-ot (az

o A lenti Data tablazatban a Young’s Modulus ala irjuk be a rugalmassagi
tényez6t, azaz 2e5 (MPa) —t, a Poisson’s Ratio ala pedig a Poisson
tényez6t, azaz 0.3-at.

Module: | Property

2= Edit Material

N

[43

dl Create
:T: Matenal

Desci

ame: | acél

ription:

Material Behaviors

General | Mechanical Thermal  Electrical/Magnetic  Other

Elasticity
Plasticity

Damage for Ductile Metals

Damage for Traction Separation Laws

v v

.

Damage for Fiber-Reinforced Composites &

Damage for Ela:

stomers

Super Elasticity

»

Hyperelastic
Hyperfoam

Low Density Foam
Hypoelastic
Porous Elastic

Viscoelastic

5+ Edit Material X

Name: | acél

Material Behaviors

General  Mechanical Thermal  Electrical/Magnetic  Other v
Elastic

Type: | Isotropic M * Suboptions
[ Use temperature-dependent data
Number of field variables: 0lF
Moduli time scale (for viscoelasticity): Long-term |
[ No compression
[ No tension
Data

Young's Poisson’s
Modulus Ratio

o, Bty
r oK Cancel
: |
B1.1 | B1.2 B1.3

2. Section definialasa: A Property Modul eszkoztarabdl kattintsunk a Create Section ikonra.

Az ekkor megjelend Create Section ablakban az alabbi beallitasokat végezzik el:
e A Category alatt valasszuk ki a Solid —ot

e A Type alatt valasszuk a Homogeneous —t

Ezutan kattintsunk a Continue... gombra. Az ekkor megjelené Edit Section ablakban
a Material mellett megjelent az el6z6 pontban definialt acél (t6bbféle anyag esetén itt
valaszthatnank ki a kivant anyagot). Kapcsoljuk be a pipat a Plane stress/strain
thickness —nél és irjuk be a lemez vastagsagat azaz 5-6t. Ezutan kattintsunk az OK

gombra.
Medule: | Property IE S Create Section x
% Edit Section P
7 @ Name
Mame: Section-1
mg Category — Type
il @ Solid Type:  Solid, Homogeneous
j;i SCreta.te (O Shell Generalized plane strain i .
E. ::J'U” o Eulerian Material: | acél e |fr—E
== eam
nZna Composite r : -
- \t"t (0) Other Plane stress/strain thickness: | 5
é‘ E = OK Cancel
£ P
B3.1 B3.2 B3.3

3. Section geometridhoz rendelése: Ehhez kattintsunk a Property modul eszkoztarabdl az

Assign Section ikonra. Ezutan jeldljik ki az egész geometriat, majd a lenti beviteli
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mezbben kattintsunk a Done gombra. Ekkor megjelenik az Edit Section Assignement
ablak, ahol kivalaszthatjuk a section-t. Mivel csak egy section-t definialtunk, igy csak OK-
zuk le az ablakot.

Module: |3 Property
=

WD
4

Assign
Section

g SE,

e
®=

A

B4.2

B4.1

B4.3

4= Edit Section Assignment >
Region

Region: Set-1

Section

Section: | Section-1 M %

Note: List contains only sections
applicable to the selected regions.

Type  Solid, Homogeneous

Material: acél

Thickness

Assignment: (®) From section () From geometry

oK Cancel

Select the regions to be assigned a section ( Create set: | 581

o

B4.4

o \MODULE | ASSEMBLY osszeallitas

Ennek a lépésnek tobb alkatrészbél allé szerkezetek esetében van igazan jelentésége, mivel
itt tudjuk létrehozni az 6sszeallitast. Jelenleg csak egy alkatrészink van, ennek ellenére nem
hagyhato ki a I1épés, készitenunk kell egy egy alkatrészbdl allé dsszeallitast. Ehhez kattintsunk
az Assembly modul Create Instance ikonjara, majd a megjelend ablakot OK-zuk le.

= Create Instance e
Module: - Assembl}r Create instances from:
@Par‘ts (O Models
Awan | ] T
nvn Parts
& :
=| Create
A Instance
=
i @
Instance Type
;"]: ||+ (®) Dependent (mesh on part)
=, 93 )
: O Independent (mesh on instance)
= Note: To change a Dependent instance's
mesh, you must edit its part's mesh.
R | [] Auto-offset from other instances
o Apply || Cance

o] MODULE | STEP lépések megadasa

A Step modulban a végrehajtando vizsgalat(ok) tipusat (pl. statikus, dinamikus, hétani...), azok
részleteit és sorrendjét tudjuk beallitani. Jelenleg 1 db statikus Iépést kell definialnunk. Ehhez
kattintsunk a Step modul Create Step ikonjara. a megjelené Create Step ablakban nevezzuik
el a lépést: a Name -nél. A Procedure type-nal valasszuk a General-t és a Static, General -t.




Ezutan kattintsunk a Continue... gombra, majd a megjelené Edit Setup ablakban hagyjunk
mindent alapértelmezésen, csak OK-zuk le.

S5 Create Step x
& o
Marme: | Step-1 5 EditStep ®
= Mame: Step-1
Module: |7 Step ~ Insert new step after Type: Static, General
e E Descrition:
Time period: |1
e Create Nigeorn: ® Off (This setting controls the inclusion of nonlinear effects
" Step (Jon  of large displacements and affects subsequent steps.)
1 Automatic stabilization: None M
11040 iew
k- Proceduret}rpe: General e [ Include adiabatic heating effects
R‘ o Dynamic, Temp-disp, Explicit L
r:!m 3; Geostatic
e Heat transfer
[avz) i#\ Mass diffusion
+ . wiu, Soils
.-j"j : Static, General
— -"-+ . .
2 4 Static, Riks W
& 2 =
Cancel
] MODULE | LOAD peremfeltételek megadasa

A Load modulban tudjuk megadni a kinematikai peremfeltételeket (megfogasokat) és
dinamikai peremfeltételeket (terheléseket). Jelen feladatban 2 megfogast (szimmetria
tengelyek) és 1 terhelést (1 vonal mentén megoszlé erd) kell definialni.

1. megfogasok definialasa: (az alabbi lépéseket kétszer kell végcsinalni)

e Kattintsunk a Load modul Create Boundary Condition ikonjara.

o A megjelené Create Boundary Condition ablakban nevezzik el a megfogast
fliggbleges szimmetrai-nak, illetve vizszintes szimmetria-nek, a Category-t
hagyjuk az alapértelmezett Mechanical-on, a Types for Selected Step alatt pedig
valasszuk ki a Symmetry/Antisymmetry/Encastre-t. Ezutan Kkattintsunk a
Continue... gombra.

e Jeldljuk ki a rajzon a fuggéleges szimmetria, illetve vizszintes szimmetrai helyét
(kijeloléskor egy piros vonal jelenik meg a kijeldlés helyén).

¢ A lenti beviteli mezében kattintsunk a Done-re

o Az ekkor megjelend Edit Boundary Condition ablakban a fliggéleges szimmetria
esetén valasszuk a XSYMM (U1=UR2=UR3=0), vizszintes szimmetria esetén
pedig a YSYMM (U2=UR1=UR3=0). OK-zuk le az ablakot.

fluggéleges szimmetria tengely vizszintes szimmetria tengely
Module: |5 Load : Module: |5 Load :
ks B Lt B2
Create f Create
Boundary Boundary
Condition [ Condition
e e |




El.1

E1.6

5+ Create Boundary Condition >
Mame: |fuggéleges szimmetria
Step: | Step-1 e

Procedure: Static, General

Category Types for Selected Step

® Mechanical Symmetry/Antisymmetry/Encastre

(O Electrical/Magnetic Displacement/Rotation
) Other Velocity/Angular velocity
Connector displacement

Connector velocity

Continue... Cancel

5 Create Boundary Condition X

Mame: | vizszintes szimmetrid

Step: | Step-1 e
Procedure: Static, General
Category Types for Selected Step

() Electrical/Magnetic | Displacement/Rotation
O Other Velocity/Angular velocity

Connector displacement

Connector velocity

Con Cancel

E1l.2

ELl.7

E1.8

E1.3
\

Select regions for the boundary condition { [7] Create set: ) mﬁ

Select regions for the boundary condition ( Create set: ) m

El.4

E1.9

5+ Edit Boundary Condition *

Mame: faggdleges szimmetria

Type:  Symmetry/Antisymmetry/Encastre
Step: Step-1 (Static, General)

Region: Set-1

CSYs: (Global) [ L

(®) HSYMM (U1 = UR2 = UR3 = 0

() WSYMM (U2 = UR1 = UR3 = 0)

() ZSYMM (U3 = UR1 = UR2 = 0)

(O XASYMM (U2=U3=UR1=0; Abaqus/Standard only)
O YASYMM (U1=U3=UR2=0; Abaqus/Standard only)
(O ZASYMM (U1=U2=UR3=0; Abaqus/Standard only)
(O PINNED (U1=U2=U3=0)

(O ENCASTRE (U1=U2=U3=UR1=UR2=UR3=0)

OK Cancel

% Edit Boundary Condition *

MName:  vizszintes szimmetria

Type:  Symmetry/Antisymmetry/Encastre
Step: Step-1 (Static, General)

Region: Set-2

CsYS: (Global) [3 L

(O XSYMM (U1 = UR2 = UR3 = 0)

(®) ¥YSYMM (U2 = URT = UR3 = 0f

(D ZSYMM (U3 = UR1 = UR2 = 0)

(O XASYMM (U2= U3 = UR1 =0 Abaqus/Standard only)
(O YASYMM (U1=U3=UR2=1D; Abaqus/Standard only)
(O ZASYMM (U1 = U2=UR3I =0 Abaqus/Standard only)
(JPINMED (1 =U2=U3=0)
(JENCASTRE(U1=U2=U3=UR1=UR2=UR3=10)

oK Cancel

E15

E1.10




2. terhelés definialasa:

o Kattintsunk a Load modul Create Load ikonjara.

o A megjelend Create Load ablakban nevezzik el. A Category-t hagyjuk az
alapértelmezett Mechanical-on, a Types for Selected Step alatt pedig valasszuk ki
a Pressure-t azaz nyomast. Ezutan kattintsunk a Continue... gombra.

e Jeldljuk ki a geometrian a megoszIo terhelés helyét. (kijeldléskor egy piros vonal
jelenik meg a kijel6lés helyén).

¢ A lenti beviteli mezében kattintsunk a Done-re

o Az ekkor megjelend Edit Load ablakban adjuk meg az nyomas nagysagat negativ
elgjellel (mivel a fellletbdl kifelé mutat a nyomas) N/mmz2-ben azaz -40 -et. Ezt a

Ff-l _200-500_40 N

kovetkez6 szamitas alapjan kapjuk meg: p=—= =
P) P g P A vl 5.500 mm?

Terhelés megadasa

Module: | Load :

=
ET; Create
Load
= 2
b 2
E2.1
2= Create Load *
Mame:  Load-1
Step: | Step-1 |
Procedure: Static, General
Category Types for Selected Step
(® Mechanical Concentrated force 2
Moment
Pressure |

Shell edge load
Surface traction
(O Electrical/Magnetic Pipe pressure
Body force
(O Other Line load
Gravity
Bolt load
Generalized plane strain
Rotational body force
Coriolis force
Connector force
Connector moment

Continue... Cancel

E2.2

10



E2.3
Select points for the load [ [V] Create set: )]

E2.4

¥ Edit Load *

Mame:  Load-1

Type:  Pressure

Step: Step-1 (Static, General)

Region: Surf-1

Distribution: | Uniform v fix

Magnitude: | -40

Amplitude: | (Ramp) i Pb‘

oK Cancel
E2.5
Sl MODULE | MESH [halb elkészitése

A végeselem halét a Mesh modulban tudjuk elkésziteni. Legel&szoér fent az Object-et allitsuk
at Part-ra, aminek hatasara a Part mellett megjelenik a racsos tarto felirat.

Module: |: Mesh E| Model: | Model-1 E| Object: () Assembly (?{Part:} * récsos tarté :
T . |
Ezutan a haldzast az alabbi lépésekben végezzik el:

1. Felulet felvagasa:
Els6 l1épésként mivel strukturalt végeselem halét szeretnénk Iétrehozni ezért felvagjuk a
fellletet. Ehhez kattintsunk a Partition Face: Sketch ikonra. Ekkor visszakapjuk a sketch
modult amiben rajzoljuk meg a Create Lines: Connected paranccsal az a két vonalat ami

11



mentén a fellletet felvagjuk. Ezutan az Add Dimension paranccsal méretezzik be az
abran lathat6 két pontot 500 mm-re. Végul kattintsunk a beviteli mezében a Done gombra.

Module: ,:MT
fiag [,
B B
N
[=g=4
&
Ea,
=+

=, 2,

-
R, o,
ED Partition Face:
d Sketch

(x¥2) IL
& a ’l

A,

N
&

Maodule: | Mesh

Create Lines:
Connected

F1.1 F1.2 F1.3 Fl1.4
* Model-1 Ohjed:OAssemhly@Part:’m

Medule:

< Mesh ~  Model

4= > New dimension: 500

F1.5

12



2 Mesh ~  Model: | T Model-1 Object: OAssemny@ Part:| > furatos lemez

Module:

+
o m=!
Thet

= X | Sketch partition geometry

F1.6

2. Elemtipus megadasa:
o Kattintsunk a Mesh modul Assign Element Type ikonjara.
o Jeldljik ki a teljes geometriat.
o Alenti beviteli mezében kattintsunk a Done gombra
e A megjelend Element Type ablakban a Family-t allitsuk Plane Stress-re, a
Geometric Order-t pedig legyen Linear, majd OK-zuk le az ablakot.
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3.

%# Element Type

Element Library Family

(® Standard () Explicit Plane Strain

Paore Fluid/5tress
Thermal Electric

Geometric Order
® Lmear (O Quadratic

Medule: = Mesh

LY
[P~
P,

Quad  Tri

Reduced integration [ ] Incompatible modes
Element Controls

Hourglass stiffness:

(®) Use default (O Specify

Note: To select an element shape for meshing,
select "Mesh-> Controls” from the main menu bar.

Plane Stress

Eﬁa g Viscosity:
— Second-order accuracy: (O Yes @ No
Assign Distortion control: @ Use default O Yes O No
Element Type
_'a = g o: |01
e — Houralace contral: (@) ea defankt () Enhancad (7 Ralax ctiffnece () SHffnece () Viccaus OV Cambined

CPS4R: A 4-node bilinear plane stress quadrilateral, reduced integration, hourglass control.

A

~

OK

Defaults Cancel

F2.1 F2.2

F2.4

Elemmeéret megadasa:

Ehhez az alabbi |épéseket végezzik el:
e Kattitnsunk a Mesh modul Seed Part ikonjara.

o A megjelené Global Seeds ablakban az Approximate global size mezében irjunk

be 15-6t. Ezutan OK-zuk le az ablakot.

25 Global Seeds *

Sizing Controls

Approximate global size: ‘Ii

Madule: |5 Mesh
o

Curvature control
Maximum deviation factor (0.0 < h/L < 1.0): | 0.1
(Approximate number of elements per circle: 8)

Minimum size control

(®) By fraction of global size (0.0 < min < 1.0) | 0.1

| €
e =

() By absolute value (0.0 < min < global size) |5

x| [l

Defaults Cancel

F3.1 F3.2

Négyszdg alaku strukturalt halé megadasa: Kattintsunk az Assign Mesh Controls ikonra

ezutan jeldljuk ki a teljes geometriat majd kattintsunk a k6zéps6é gombbal. A felugré Mesh
Controls ablakban az Element Shape-nél allitsuk be a Quad-ot a Technique-nél pedig a
Structured menupontot, majd kattintsunk az OK-ra.
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Madule: |5 Mesh
fo [,
s =

F4.2

# Mesh Controls

Element Shape

Technigue
Asis
) Free |:|
B
(O Sweep |:|

Multiple

® Quad ) Quad-dominated ) Tri

Algorithm Options

Minimize the mesh transition 3"

Redefine Region Corners...

oK

Defaults

Cancel

F4.3

5. Végeselem hald elkészitése:

6.

A végeselem halo elkészitéséhez kattintsunk a Mesh modul eszkoéztaraban a Mesh Part
ikonra, majd a lenti beviteli mezében az OK to mesh the part? mellett a Yes gombra.

Module: |5 Mesh : Model:[
[
EnEs
ﬂMesh Parﬂ
T

b = 0K to mesh the part? [%]

F5.1

F5.3

F5.2

Haldtulajdonsagok lekérdezése (opcionalis)

A csomépontok és végeselemek szamanak ellendrzéséhez a Tools » Query...
Parancsot hasznalhatjuk. A felugré Query ablakban a General Queries mez&ben
kattintsunk a Mesh-re, majd a lenti beviteli mezét a Query entire part-on hagyva a Done
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gombra. Ekkor a lenti parbeszédablakban megjelenik a csomdpont szam (Total number
of nodes) és az elemszam (Total number of elements).

el MODULE | JOB | feladat megoldasa

A feladatot a Job modulba atlépve tudjuk lefuttatni. Az ehhez szikséges Iépések:

1. Feladat definialasa:
e A Job modul eszkoztarabol kattintsunk a Create Job ikonra

¢ A megjelend Create Job ablakban kattintsunk a Continue... gombra
¢ A megjelend Edit Job ablakban hagyjunk mindent alapértelmezésen és OK-zuk le

2 Edit Job =]
MName: Job-1
- .
Meodel: Medel-1
= Create Job Ié]
Analysis product: Abaqus/Standard
=
Module: |7 Job |E| Mame: | Job-1 Description:
submission | General | Memery | Parallelization | Precision
Source: | Model EI
= Job Type
Model-1 @ Full analysis
B create
Jab Run Mode
[T == @ Background () Queue:
Submmit Time
hes.| | min,
I Contipue... I Cancel o
|
i g J
m Cancel

2. Feladat lefuttatdsa:
e A Job modul eszkdztarabal kattintsunk a Job Manager ikonra
¢ A megjelené Job manager ablakban alapbdl ki van valasztva az el6bb definialt 1
db feladat (Job-1). Kattintsunk a Submit gombra.
¢ Ha a Status alatt megjelenik a Completed felirat, akkor a feladat sikeresen lefutott.
Az eredmények megjelenitéséhez kattintsunk a Results gombra.

Module: 12 1ok & Job Manager S [ 2 Job Mansger [
 |E :
Name Model Type Status Name Model Type Status
E = Fa b N
)
E\.ﬂ,E}] Job
Manager
l* = Results
@»I E= = W P /= [ Create... Edit... Copy Rename... Delete..
- 1

H R NNBRVISV/\NVZNIIOIN credmények megjelenitése

A Results gombra kattintva automatikusan a Visualisation modulba kerulunk. Fent valasszuk
ki az U-t vagy az S-t annak megfelelen, hogy az elmozdulést, vagy a feszultséget szeretnénk
megjeleniteni. EI6szo6r valasszuk az U-t.
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A Plot Contours on Deformed Shape ikonra kattintva a deformalt alakot lathatjuk.

u
14 a 4t

Bal felll 1athatd szinskala alapjan a maximalis elmozdulas 0,2912 mm.

A Common Plot Options-ban a Basic fulon beallithatjuk a deformacid felnagyitasanak
mértékét, a Labels fllén bekapcsolhatjuk a csomoépontok és elemek sorszamanak
megjelenitését.

4= Common Plot Options

-
Basic | Color & Style | Labels | Normals [ Other |

i Render Style Visible Edges
ult  Plot  Animate  R|| o wieriame © Hidden © All edges
[g:‘ . () Filled @ Shaded @ Exterior edges
{‘\ IE Tl . Deformation Scale Factor () Feature edges

() Free edges

() Auto-compute (160.603)
rH . . - =
Module: |= Visualizatid|| @ uniform © Nonuniform © No edges
Value: | 200 I ¢
e Eﬁ
L 2 N
oo L,

|Cummun Gptiuns|

& @ﬁ? [ oK ] [ Apply ] IDe‘FauIrj] I Cancel ]

A Contour Options-ban a Limits fulén bekapcsolhatjuk a max/min helyek megjelenitését.
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MIOTUIE: | VISUBIZATION % Contour Pt Optans -8 =
.. | | Basic | Color & Style | Limits | Other
Q- 423 E@ | Note: User-defined interval values override
L2134 | the settings below.
pan I L ME0 e
o H mae @ Aute compute (0.0190805) (¢! Show location
- \ |
g 14 Specty: 0190808 :
H | M @ Auto-compute () 4| Show location |
\ |
.. ! Specty | -
£ ; |
- 4| Auto-Computed Limits
J Contour C}ptiuns +| when auto-computing animation himits:
& + Use limats from all frames v{
; ase +
L, G +
@ +
Home +
0 B ‘ |
L) [ Apply | | Defeults | | Cancel
e e

Az elmozdulasok kiértékelése utan nézzik meg a redukalt fesziltség eloszlast.

E?: Primary E| u E Magnitude E|
CF

M4

E

RF

S

00
ODE; Jo odb Abag andard 3DEXPER 0 O RS
ep ep
eme ep e 000

P 5 A o
Dero ed \a Defo atio ale Facto 434e+0

18



